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Preface
This ebook was written with the beginner Mac user in mind. It was  intended to help recent 

Switchers  learn more about the Mac operating system, to expose them to the best free 

applications, to extend their productivity and to assist them with day-to-day procedures  by 

revealing useful tips and tricks from seasoned Mac users.

If you are a Switcher, this ebook will prove to be incredibly useful as it starts from the very 

beginning -- introducing the applications that come bundled with every Mac, their functions 

and how to use them. Once you're familiar with what your Mac has to offer and how you can 

make the best out of it, we'll begin to talk about plugins and third-party applications which will 

further enhance your workflow.

Along the way, I will share the tips learnt over the years after I switched to a Mac, providing 

you with first hand experience, sharing the mistakes I made so that you do not need to go 

through them yourself. 

I genuinely hope that this ebook will make your transition to Mac a smooth one.
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Chapter ONE

What’s on your 
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Some Switchers will buy a Mac without knowing what it is actually capable of 

doing. Sure, you might have heard that a Mac will help with creativity and/or productivity. 
However, your creativity or productivity isn't going to skyrocket the moment you turn on your 
newly-bought Mac. You’ll need to know how it works in order to make the most out of your 
purchase. 

So let's return to the basics. I will begin with some of the applications that come bundled  
with every new Mac, explain their functions, how to use them and where to find them.

Finder

In Windows, if you need to view the contents of your hard disk, thumb drive, CD or DVD, 
you'll would probably double-click on My Computer. In other words, you're using Windows 
Explorer.

Finder is the Mac-equivalent of Windows Explorer. It allows the user to view the contents of 
local drives, networked drives, optical drives, portable drives, folders, files and so on. Think of 
it as a store General Manager -- always on, always there, watching over everyone. Finder 
manages applications, files, disks and devices on your Mac.

There are 3  components to the Finder. These are probably the most obvious to a new Mac 
user:

• The dock
• The menu bar
• The desktop and Finder windows

You can find a representation of the Finder in each of these locations.

The smiley-faced blue icon on the dock
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The Finder menu bar item

The Finder window
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The dock
The dock is undeniably one of the main attractions when a Switcher starts to use a Mac. I 
remember the days when the dock’s ‘magnify’ function was on by default. Every time I 
walked into an Apple store, I’d roll the mouse pointer over the dock icons and watched the 
dock icons swell up and shrink. 

But the dock is so much more than just eye candy. It’s an ever-accessible venue where your 
frequently-used applications can call “home”.

The dock is divided into 2 sections by a broken line. The left section of the Dock houses your 
applications. Running applications are represented by a blue dot under them. The right 
section may be filled with anything, from images to bookmarks and even folders. Since OS X 
Leopard, these folders appear as “Stacks” and they spring up to reveal their contents. The 
number of items on the dock is virtually limitless -- it will automatically adjust its size to 
accommodate.

To add an application to the dock, simply click and drag it to a desired position, then let go. 

To remove an application from the dock, drag it off the dock and let go - it will disappear into 
a cloud of smoke - poof!

The dock can also be housed on the left or right hand side of the desktop. To change its 
position, click on the Apple icon in the menubar, select Dock and ‘Position on Left/Right’.

Quick Tips

To quickly change the size of the dock, place the cursor over 
the broken line which separates the left and right section of 

the dock, click and drag up or down to resize.

To quickly hide the dock, press Command + Option + D.
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The menu bar
The menu bar is that long bar located at the top of the screen. From left to right, it houses 
the Apple icon, application menus, menu bar applications, system icons, the time and finally, 
Spotlight.

One of the things that you must realize is that the Mac’s menu bar is dynamic. The menu bar 
will change to display the menu of the foremost application or whichever application that 
was last used.

As you can see from the screenshots above, when Finder was the main application, the 
menu bar displayed its menus. As soon as I switched over to Pages (word processor, part of 
the iWork office suite), it dynamically changed to present Pages’ menus. The active 
application is always displayed on the left, directly next to the Apple icon.

On the extreme right of the menu bar, you’ll find the relevant system icons i.e. Airport status, 
Bluetooth status, displays, sounds level, languages, battery level (portable Macs only) and 
Spotlight.

As I mentioned earlier, there are certain applications that sit on the menu bar, so termed 
“menu bar applications”. I’ll elaborate on that when we get to the section about third-party 
applications.
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The desktop and Finder windows
The Finder controls the desktop in such a way that it will display any connected devices: hard 
drives, networked drives, portable drives, iPods, CDs or DVDs and disk images.

You can easily customize the desktop to print the amount of disk space available/used, the 
number of files in a folder, the size of an image file, etc.

Simply right-click on the desktop, select ‘Show view options’ and check the box next to 
‘Show item info’.
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The Finder windows are what pop up every time you double-click on the hard disk icon on 
the desktop. These windows let you browse your Mac and view files, folder contents, launch 
installed applications and gain access into system files and utilities.

On the left of the Finder window lies the sidebar. Generally, the sidebar hosts a list of 
attached devices, networked drives, a customizable list of places/locations on your Mac and 
a slew of quick search terms that can easily help you to find your files.

If you are connected to a network with Windows PCs or other Macs, they will appear in your 
Finder sidebar under ‘Shared’.

The sidebar is customizable. You can drag anything you like onto the sidebar for easy 
access. 

Likewise, you can also remove any of the sidebar items to prevent them from showing up. 
Just click and hold, then drag them off the sidebar.

Quick Tip

Your Pictures, Movies, Music, Documents and Download folders 
are located within your Home folder
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Using Finder
Just like Windows Explorer, Finder can be used to inspect file properties i.e. sizes, modified 
or created dates and so on.

There are several ways to do this.

Get Info
Right-click on the file and choose ‘Get Info’ from the contextual menu. 

The Get Info window will appear, showing you the file’s details as well as providing you a 
chance to label it with a color, lock the file to prevent deletion, select the default application 
for that particular type of file and control user permissions.
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You can also accomplish this by clicking the file once and pressing Command + I. Not to 
mention, you can open an unlimited number of Get Info windows for multiple items, they will 
automatically align themselves next to each other.

Column view
When in a Finder window, you can easily reveal a file’s basic properties by changing the view 
mode to ‘Column’.

Quick Tip

To change the view mode within a Finder window, press:
•Command + 1 for Icon view
•Command + 2 for List view
•Command + 3 for Column View
•Command + 4 for Cover Flow view
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Inspector
If there is ever a need to check the details of more than one file individually without manually 
opening a Get Info window each time, there’s Inspector.

Inspector is basically a ‘Get Info’ window that dynamically updates to show you the file 
properties of every file that you click on. This sidesteps the issue of having too many Get Info 
windows. Using Inspector, you get one Get Info window that changes the instant a new file is 
selected.

There are 3 ways to invoke the Inspector.
• Pressing Command + Option + I
• Right-click a file, hover the cursor over ‘Get Info’, press the Option key and watch as 

‘Get Info’ changes to ‘Show Inspector’
• With Finder in focus (the frontmost application), click on the File menu, hover on ‘Get 

Info’, press the Option key and again, it will change to ‘Show Inspector’
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Quick Look
First introduced in OS X Leopard, Quick Look was a breakthrough feature. It would allow a 
user to preview the contents of any supported file instantly. Quick Look has managed to 
change the way most Mac users preview their files. And in Snow Leopard, several new 
features have been added to Quick Look’s arsenal.

Conventionally, if one needed to view a document, for instance a PDF file, they would have to 
double-click on the file to launch Preview or Adobe Acrobat in order to browse through the 
PDF.

Now, all a user needs to do is hit spacebar while the PDF file is highlighted and Quick Look 
will pop up with a preview, instantly.

The same technique applies to audio/video files, documents, images, mail attachments, etc.
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In  Snow Leopard, Apple added the ability to Quick Look documents and files without 
triggering a Quick Look window. Instead, file icons are now displayed in high resolution (up to 
512 pixels) and are true to their content.

Hovering the cursor over documents supported by Quick Look triggers specific controls.

In the screenshots below, the file’s icon has been enlarged almost to the maximum. As you 
can clearly see, it is not a generic Pages icon but rather a true reflection of the content within 
the document. Using the right and left controls that appear at the bottom, I can literally flip 
through the document without launching Pages.

Still the same document, showing a different page. Remember, this is a file icon.
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Here is another example of Quick Look previewing a video file within its file icon in Finder.

It is seriously a revolutionary and powerful technique of previewing files without launching 
their associated applications, saving you precious time and allowing you to get on with your 
work.

Quick Tip

You can preview videos from its file icon. While it is playing, 
press Spacebar and a Quick Look window will open, providing 

you with a larger preview.
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Spotlight

Spotlight is Mac’s innate search engine. To invoke Spotlight, all you need to do is click on the 
magnifying glass icon in the top-right corner. Spotlight searches and returns the results in real 
time.

When idle, it will index the entire computer; the process is represented by a dot in the center 
of Spotlight’s magnifying glass icon. During this time, your Mac may seem to respond 
sluggishly but rest assured that it is only temporary until the process of indexing is complete. 
Spotlight will also start to index if there is a sudden influx of new files. Although you may hear 
whirring noises, this is absolutely normal -- it takes additional CPU power to index a lot of files 
and the fan will kick in to cool down your Mac.

Using Spotlight
Spotlight is a great way to search for files quickly. Besides that, Spotlight will also find 
Address Book contacts, iCal events, search through emails, PDFs, media files and 
applications. As long as you have a rough idea of what to look for, type in a search term and 
watch as the results come to life and narrow down to your possible target files.

Quick Tip

To bring up the Spotlight search field, press Command + Space.
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Spotlight categorizes search results based on file type. If you prefer not to have Spotlight 
show certain types of files or locations, you can easily set this in Spotlight’s Preferences 
(System Preferences -> Spotlight).

In the ‘Search Results’ tab, you may customize the results by order of appearance and even 
choose not to display results from certain applications.

In the ‘Privacy’ tab, you may enter locations where you do not want Spotlight to search. To 
add a location, press the plus button and browse to the location you want to keep private.
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Advanced Searching
Searching for filenames may be sufficient for most people but Spotlight is innately so powerful 
that it would be a shame not to share these advanced searching tips.

The tips that follow have not been documented by Apple and are therefore incomplete.

Searching for a specific filetype
Using the syntax kind:, it is possible to narrow the search specifically to images, music, PDF, 
Word documents, Pages documents, text, bookmarks, history, mail, ZIP files, etc.

For example, to quickly find my Summer ’09 PDF amongst all the mail I have with the same 
title, all I need to enter is ‘kind:pdf summer’ and Spotlight would have found the file for me.

Search by metadata
All files store metadata -- simple file descriptions embedded into them but not clearly stated 
in the file name. For example, a Composer or Artist name are metadata that Spotlight can 
effortlessly search for.

Let’s say I want to play a song from John Mayer’s ‘Heavier Things’ album. All I need to do is 
invoke Spotlight by pressing Cmd + Spacebar and enter ‘album:heavier things’
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If I wanted to search for all the songs in my library by Bach, I’d simple enter ‘composer:bach’

There are heaps of other metadata search syntaxes that are available but again, they’re not 
documented so finding out about them is more or less a game of trial and error.

Here are a few more syntaxes:

bitrate: Bit Rate
by: Song Artist
codec: Media Codec
composer: Song Composer
genre: Genre

height: Image height in pixels
width: image width in pixels
ISO: Image ISO
aperture: Image aperture

to: Recipient
from: Sender
subject: Mail Subject
date:mm/dd/yyyy Date sent or received
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Using operators
Operators like > and < as well as - come in very handy when searching within a range of 
dates and other attributes.

If I needed to look for email messages received after 1st July 2009, I would enter:

kind:mail date:>7/1/2009

As you can see, multiple search syntaxes may be used in tandem to narrow down the search 
even further.

If you’d like to see all the images taken between 10 January 2009 and 30 March 2009, enter:

kind:image date:1/10/2009-3/30/2009

These are only a few ways to utilize the powerful search capabilities within Spotlight.

Launching Applications
Spotlight has seen dramatic improvements over the last few releases of OS X. In the course 
of that, launching applications became so much simpler.

Invoke Spotlight by pressing its hotkey, Command + Spacebar. Type the first few letters of 
the application you wish to launch and Spotlight would have found it for you. The more 
frequently you launch an application with Spotlight, the quicker it will be fetched and possibly 
ranked at the top.
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This section will briefly touch on several cool and useful built-in applications that 

everyone who owns a Mac should be introduced to.

Buying a brand new Mac comes with several benefits. iLife comes bundled with every new 
Mac and that’s always something to acknowledge. One particular component of iLife is used 
everyday, all over the world. That’s iTunes.

iTunes

iTunes is Apple’s multifunctional media player. But it doesn’t end there, iTunes also plays host 
to the infamous iTunes Store for songs, TV shows and movies; not forgetting App Store, the 
holy grail for iPhone and iPod Touch users.

Not everyone will be satisfied with iTunes and there will always be a small group of users who 
are, for lack of a better term -- rebellious. For those users, several alternative Mac media 
players are available -- Songbird is one of them. Head over to MakeUseOf for a review [http://
www.makeuseof.com/tag/songbird-10-hatches-download-it-now/]

When using alternative music players, keep in mind that syncing compatibility may be an 
issue. You may not be able to sync music to your iPod or iPhone if an iTunes library doesn’t 
exist.
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However, if you’re looking for a sleek and effortless way to organize your music, TV shows, 
movies, audiobooks, podcasts and applications for your iPhone and iPod Touch -- then 
iTunes is the perfect solution. Its unique interface is unrivaled in terms displaying large music 
libraries; and because of that, the task of organizing with iTunes is a breeze.

For more information about iTunes, visit MakeUseOf to download The BIG Book of iTunes 
[http://www.makeuseof.com/tag/the-big-book-of-itunes/] with cool tips and tricks to juice up 
your iTunes experience.
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Apple’s Productivity Suite

Many people often say that using a Mac will boost your productivity. It’s not just a load hot air. 
Using a Mac will indeed make you more aware of your work, and less of your computer -- if 
used properly.

By placing a lot of unimportant detail and notifications out of view, you are then more focused 
on the task at hand. Besides that, Apple has written several great applications that go so well 
with each other, it’s unbelievable. These apps deal with your email, schedule and contacts; 
they’re known as Mail, iCal  and Address Book and they all work hand in hand to provide 
you with the most seamless user experience you can find in any operating system.

Mail
If you haven’t used Mail before, don’t be afraid to dip your feet in. Mail is so intuitive and very 
simple to use. After setting up, it logs into your mail account and downloads all your mail to 
your Mac. There are several advantages to this. First, you can have offline access to your 
mail. Second, you are able to use Apple’s Quick Look technology to preview your 
attachments without launching Microsoft Word or any other associated applications.

On the left, you have a list of accounts that Mail is currently managing. Smart Mailboxes that 
have been created by using specific search terms and any RSS feeds will also be displayed 
here.
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Mail’s Setup Assistant makes it incredibly easy to add your IMAP or POP email account.

Here’s a quick run through of how to set up a Gmail account in Mail.

1. Before starting, make sure to enable IMAP from your Gmail settings. For step by step 
instructions, please read: [http://mail.google.com/support/bin/answer.py?answer=77695]

2. Launch Mail.
If you’re doing this for the first time, the Setup Assistant will run automatically. If not, select 
Preferences from the File menu.

3. In the ‘Accounts’ tab, click on the plus sign on the bottom left hand corner.
4. The Setup Assistant will now guide you to add a new email account.

Simple enter your email address and the password then hit ‘Continue’.

The Setup Assistant is smart enough to automatically detect your email provider and account 
type in the case of Gmail, Hotmail and Yahoo accounts.
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If you use a Google Apps account and have a customized email address, the following page 
will be presented to you, where you are able to fill in your account details.

Admittedly, depending on the speed of your internet connection and the amount of emails 
you have, it will take some time to download and store all of your mail and their attachments. 

Like I said before, the operating system will not show unimportant details but if you’d like to 
be aware of the downloading progress, open up the Activity Viewer from the Window menu 
or hit Command + 0.
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What gives Mail the advantage over other desktop mail clients is the well thought out 
integration between iCal and Address Book.

Mail analyzes the email content for addresses, names and phone numbers as well as dates 
and times. Any data that is detected will be surrounded by broken lines when you hover the 
cursor over them.

Right click on an address or telephone number to automatically create a new contact or add 
them to an existing contact
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If an email contains dates, times and keywords like “tomorrow”, “next Tuesday”, Mail will 
detect them and allow you to create an iCal event without launching iCal.

Look what happens when I receive an email inviting me for a game of squash:

Mail detected the keyword “8pm” from the email and that allowed me to add that in my iCal 
schedule. All of the field were filled automatically by Mail.

And finally, here’s the event in iCal. Notice how easy it was done?
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iCal
If you’ve dealt with to-do applications or time-management software in the past, you’ll be 
amazed at how easy iCal is to use.

This is iCal’s main window and interface. On the left, the sidebar lists all the different 
calendars you have for personal use, work, projects and subscriptions. To add new 
calendars, click on the ‘add’ button on the bottom left corner.

You can easily toggle the calendars to display only the ones you want to see at any given 
time by checking the box next to it.

You can also switch between Day, Week and Month views (in order of increasing detail).
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If you currently use Gmail and Google’s Calendar service, you can effortlessly integrate iCal 
into the mix (OS X 10.5 and higher), allowing you to edit your Google Calendars directly on 
your desktop. Here’s how:

1. Launch iCal and enter its Preferences by clicking on the iCal menu -> Preferences, or you 
could hit Command + comma

2. Click on the Accounts tab
3. Click on the Add button on the lower left corner
4. Enter your Gmail address and the password
5. Click ‘Create’ and you’re done!

If you are a Google Apps user and have a customized email address, you can still use iCal.

1. Enter your customized Google Mail username and password, as shown below

2. This is the additional step. Type in your full email address as the username, fill in the 
password and make sure that the server address is set to “google.com”
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3. iCal will verify your credentials and if it is successful, your Google Calendars will be 
displayed.

For further instructions or help with troubleshooting, visit [http://www.google.com/support/
calendar/bin/answer.py?hl=en&answer=99358#ical]
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Like I’ve said before, Mail, iCal and Address book are all integrated and intertwined with each 
other. Why does this matter? Well, it makes creating and sharing events with your friends and 
family a breeze.

Let’s go through a simple example. Say, I’d like to organize a picnic with some of my close 
friends. All I need to do is double-click on a suitable date. iCal will then let me fill in the details 
of the event:

Now say, I want to email my friends to let them know about it -- iCal will do it for me 
automatically if I add them as invitees.
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Click on ‘Send’ and each invitee will receive an email just like this:

How simple was that?

Actually, that example had several prerequisites, one of them includes setting up Address 
Book.

Address Book
If you own an iPhone, Address Book shouldn’t be new to you. Every time you connect your 
iPhone, your contacts and their details are automatically synced.

Address Book is your personalized contact manager. You can use it to store phone numbers, 
email addresses, IM handles, birthdays, home addresses, and then assign a picture to be 
used for their caller ID on your iPhone.

To select the fields you want to use, enter its Preference and click on the Template tab. From 
there, you are able to customize the entire template -- add, arrange and preset those fields to 
your liking.
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On the leftmost column, Address Book displays any contact groups you have. To create a 
contact group, press the ‘Add’ button below the column.

Name your newly-created group and start dragging contacts in.

Having ‘groups’ is a really easy way to manage your contacts. You can also use 
‘groups’ as a mailing list. When composing a group email, just type in the name of your group 
in the Recipient field and Mail will automatically add every contact from that group.

So those are just a few things you should know about Mail, iCal and Address Book. They’re 
work very well together, really simple to use and can easily integrate into your daily life.

Quick Tip

You can set a contact as your own.

Add a new contact, fill in the appropriate fields. When you’re 
done, click on the glowing blue ‘Edit’ button. Then, click on the 

Card menu -> Make this my card
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Utilities

Every operating system will have its unique set of system utilities. Apple’s utilities are located 
in the Utilities folder [/Application/Utilities]. Within that folder, you will find many useful tools 
that can help you with a variety of task. However, I’d like to showcase two which I think will 
come in handy.

Activity Monitor
Activity Monitor is akin to Window’s Task Manager. It displays a list of every running 
application and background process. Alongside that, it will also display their CPU and RAM 
usages. Using this utility, you can easily identify applications that have halted or aren’t 
responding and take action accordingly.

Below the list of processes, Activity Manager also displays CPU activity, System Memory 
usage, Disk activity and usage as well as Network activity; divided across several tabs.

Just by looking at the list of processes, you can roughly gauge your system’s performance 
and tell the cause of a slowdown by observing the CPU usage of specific processes. 
Unresponsive applications are labelled in red and they can be terminated by pressing the 
large ‘Quit Process’ button at the top. Bear in mind that any unsaved work will be lost if 
an application is forced to quit.
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In the past, I’ve found that some unresponsive applications may be unfrozen by sending 
either a ‘Hangup’, ‘Interrupt’ or ‘Kill’ signal. Select the application in question and click on the 
View menu, then ‘Send Signal to Process’ and select Hangup, Interrupt or Kill. For more 
information on frozen applications and reviving them using Activity Monitor, visit [http://
www.makeuseof.com/tag/macnifying-os-x-learning-to-utilize-activity-monitor/]

Activity Monitor is also a great tool to judge if your Mac has sufficient memory in order to 
perform efficiently. If you often suffer from the “Spinning Wheel of Death” [http://
en.wikipedia.org/wiki/Spinning_wait_cursor], then it’s a good idea to use Activity Monitor to 
confirm your worries.

When the physical memory (or more commonly known as RAM -- Random-access Memory) 
is full and needs to unload information to the hard disk, the procedure is known as a Page 
Out. The opposite procedure is known as a Page In. The less RAM you have, the more 
pagings will take place. This tremendously slows down your Mac.

Observing the Page Out/In values in Activity Monitor is an easy way to gauge if you have 
sufficient RAM. If these values grow right in front your eyes, it’s a clear sign to add more 
memory.
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In the screenshot above, my Mac has transferred 40.9MB in Page Outs. This value is still 
within decent range, considering that I’m running several memory-intensive applications like 
Safari and Pages; not to mention operating for more than 4 days without shutting down.

Quick Tip

If you notice that your Page Out value is several times the 
amount of physical memory (RAM) installed on your Mac, you 

should really consider adding more RAM.
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Disk Utility
Disk Utility is Mac’s version of Window’s Disk Management tool. It basically helps with 
formatting, erasing and partitioning drives; verifies them and fixes disk permissions; and is a 
really easy-to-use CD/DVD image tool.

Because Disk Utility can verify and repair disk permissions, it is therefore a troubleshooting 
tool as well. If you find that your Mac is acting weird, the absolute first thing to do is launch 
Disk Utility and repair your disk permissions. Most of the time, this will eradicate the issue at 
hand.

Disk Utility also allows you to easily create DMGs and disk images from physical CDs or 
DVDs, hence eliminating the need for third-party applications. 

Interesting, Jeffry taught his readers to install Snow Leopard from a USB thumb drive and the 
only tool he used was Disk Utility. Find out how he did it: [http://www.makeuseof.com/tag/
upgrading-your-mac-to-snow-leopard-using-your-usb-drive/]
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Not only can Disk Utility create disk images, it can also mount them. Sometimes, the Finder 
would open an ISO image file as a regular folder in order to allow you to read its contents. 
However, some ISO files work better if they are mounted as an emulated disk drive. This is 
where Disk Utility comes in.

Instead of paying $100 for Toast Titanium, you can easily mount any disk image as a physical 
disk using Disk Utility. Simply drag the ISO file to the source list in Disk Utility and click 
‘Mount’. Or click File -> Open disk image.

Create password-protected DMGs
Personally, I have a secret love for Disk Utility because it allows me to create password-
protected DMGs. I frequently use passworded DMGs to store sensitive documents but you 
can use them to store anything that you’d like to keep away from peering eyes.

Here is how you can go about making your own password-protected disk image.
1. Click on File ->New -> Blank Disk Image
2. Type in an appropriate name and select the destination
3. Choose from one of the preset sizes or customize your own
4. Select either 128- or 256-bit encryption then click ‘Create’ 

Quick Tip

Use Disk Utility to create password-protected DMGs to securely 
protect sensitive documents.
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You will be then asked to input a password which will be used to encrypt the DMG. Be sure 
to enter a strong password and uncheck the box next to “Remember password in my 
keychain” or Finder will automatically retrieve your password and mount the image -- 
essentially rendering the whole point of creating a passworded DMG moot.

Sometimes, I like to throw nosy people a curve ball and store my sensitive documents within 
two passworded DMGs: I have one password-protected DMG with my files in it. Then, create 
another DMG, protected with a different password and save the first DMG in it. In short, I 
have one DMG protecting another DMG. This method is not completely foolproof but it 
will deter casual intrusions of privacy from a co-worker or roommate.

Quick Tip

Wrap one passworded DMG around another passworded DMG to 
create a two-layer defense for your sensitive files
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Chapter THREE

Third-party Apps & 
plugins

Page 45



In the previous chapter, we’ve taken a step back, broadened our view and explored the 

basics of what a Mac has to offer. Now, we will proceed to showcase applications (and 
plugins) to enhance your everyday workflow.

10 Great Free Apps

Let’s start with some essential applications. These are the apps I can’t live without and use 
on a daily basis. Most of them are set to start on login, which means that they are always on 
and ready to rock and roll whenever I call on them.

Depending on what you do with your Mac, you may or may not find this list helpful. 
Nevertheless, the majority of Mac apps are so easy to install -- there’s no reason not to try 
them out!
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iStat Menus
Category: System utilities, menubar app

Remember when I mentioned that OS X intentionally denies you of any unimportant detail? 
Well, some people actually prefer to know their Mac’s core temperature at all times. Then, 
there are people who can’t work without knowing the CPU and network activity. Others need 
to know how much of their memory is free and how much is taken up. 

For those people, there is iStat Menus.

iStat Menus is a menubar application and its sole purpose is to allow you to view details 
regarding the CPU, hard disk, network and temperature. It may be overwhelming for some 
but for control freaks, there’s nothing better.

Read more about iStat Menus here: [http://www.islayer.com/apps/istatmenus/]
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Dropbox
Category: File-sharing

Dropbox is a file-sharing, synchronizing and backup solution that is very innovative. It 
dedicates one folder on your Mac (set as default to ~/Dropbox/) to be synchronized so 
everything that is dumped into that folder will be uploaded to the Dropbox server and synced 
across every computer authorized with the same Dropbox account.

The thing I like most about Dropbox is its ease of use. How difficult is it to drop a file into a 
folder to upload it to the Dropbox server and share?

With its syncing feature, changes to a file are automatically registered without the need to re-
upload. That makes it really easy to collaboratively edit a file among several people on 
different computers (logged into the same Dropbox account).

Read more about Dropbox here: [https://www.getdropbox.com/] and [http://
www.makeuseof.com/tag/dropbox-review-invites-and-7-questions-with-the-founder/]
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The Unarchiver
Category: Archiving tool, Utilities

Sounds like a great movie title, doesn’t it? 

The Unarchiver adds support for RAR, 7Zip, Stuffit, Gzip, Tar, GNU Tar, ACE, CAB and many 
more file archive formats that would normally stump Mac’s innate archive utility.

It’s fast, too. Extracting a 700MB sequential RAR archive took less than 20 seconds. 
Depending on the type of processor you have, your results may vary.

Read more about The Unarchiver here: [http://wakaba.c3.cx/s/apps/unarchiver.html]
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Skitch
Category: Image editor

Skitch is an awesome image editor and screenshot-capture tool as well as a image sharing 
service, all bundled together in a compact application. In fact, images from this very ebook 
was put together by Skitch.

It’s great for taking quick snapshots of your screen, adding annotations, drawing arrows and 
sharing them with your friends and colleagues. You can save your images in different file 
formats e.g. PNG, JPG, GIF, SVG, PNG, BMP, TIF easily by pulling the “drag me” tab at the 
bottom of the window.

If you have a built-in iSight, it can also take your picture and allow you to edit it before saving 
or sending to a friend.

Read more about Skitch here: [http://skitch.com]/ and [http://www.makeuseof.com/tag/
capture-edit-and-share-your-screenshots-with-skitch-mac-only/]
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Shadow
Category: Clipboard manager, Utilities

By far the best clipboard manager I’ve used to date. It supports multiple clipboards which 
includes a system clipboard that registers everything that is copied (even images, links and 
styled text) and an unlimited number of customized clipboards that you are able to share over 
a network!

Shadow is invoked using a hotkey. You can then browse through everything that was copied 
to your clipboard, double-click to make it the active object and paste it.

By default, it stores up to 200 recently copied items so your list may get a little cluttered. To 
cure that, Shadow has a search function. 

Read more about Shadow here: [http://www.theescapers.com/shadow/index.html] and 
[http://www.makeuseof.com/tag/the-best-free-multi-item-clipboard-managers-mac-only/]
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Perian
Category: Quicktime plugin

Quicktime is great but its Achilles heel is the inability to play anything other than Quicktime 
Movie files -- which is, needless to say, a quintessential feature.

Perian adds support for almost every video and audio format (except for Windows Media 
Video), bringing Quicktime back to life. For WMV support, there’s Flip4Mac [http://
www.microsoft.com/windows/windowsmedia/player/wmcomponents.mspx]

Read more about Perian here: [http://perian.org]
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Daphnism
Category: File-sharing

I actually have a personal attachment to Daphnism because I helped to develop (or rather just 
beta-test) this fantastic application. If you are a frequent DivShare user suffering from the 
death trap that is the flash uploader, this is your panacea.

Daphnism is a desktop client for DivShare’s online file-sharing service. It will allow you to add 
as many DivShare accounts as you want, upload, download, share file links, edit and delete 
files from your account -- from the convenience of your Mac.

Daphnism is still in beta but the developer and I are constantly working together to fix bugs 
and add new features.

Read more about Daphnism here: [http://inventivesoft.net/products/daphnism.htm] and 
[http://www.makeuseof.com/tag/attain-divshare-nirvana-with-daphnism-mac-only/]
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Keyboard Cleaner
Category: Utilities

This application will prove to be an invaluable tool for MacBook users. It allows one to clean 
the keyboard and disregards any keystrokes while the application is running.

The dedicated media control keys will still be recognized. This was implemented out of 
consideration by the developer, so that you can quickly mute or pause iTunes in case a call 
comes through.

Read more about Keyboard Cleaner here: [http://jan.prima.de/~jan/plok/archives/48-
Keyboard-Cleaner.html] and [http://www.makeuseof.com/tag/quickly-clean-your-laptop-
keys-with-keyboard-cleaner-mac-only/]
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Bowtie
Category: Music

It’s not only about work, work, work on a Mac. Playtime is great fun and Bowtie is eye candy 
while listening to music. It is a  theme-able iTunes companion which will display the album 
cover art on the desktop.

With Growl and Last.fm scrobbling support, it’s a great way to enjoy and expand your music 
collection. Bowtie allows you to rediscover your music is style.

Bowtie itself doesn’t contain any themes. Fret not, there is a collection of 11 great free 
themes here: [http://macthemes2.net/forum/viewtopic.php?id=16790844] 

Read more about Bowtie here: [http://bowtieapp.com/] and [http://www.makeuseof.com/
tag/control-itunes-in-style-simplicity-with-bowtie-mac/]
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Adium
Category: Instant messaging

Adium is a multi-protocol, customizable, skin-able, extendable, basically everything-able 
instant messenger. It allows you to connect to almost every popular chat network like MSN, 
Yahoo!, Jabber, AOL, Facebook, Gadu-Gadu, GTalk and ICQ.

To see what Adium is capable of doing, head over to its Xtras website [http://
www.adiumxtras.com/] where you will find just about every plugin, contact list theme, status 
icon, dock icon and extra sound theme available.

Read more about Adium here: [http://adium.im/]
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There are less software for Mac than there are for Windows so don’t be surprised if 

you favorite Windows program is not available on the Mac platform. There are however, a 
myriad of great applications for Mac that do just about everything imaginable.

I’ve just shown you 10 of my favorite apps. Now, I’ll attempt to break down most of the 
available (and free) applications into groups and list down the popular applications for every 
purpose. Think of it as a crash course in Mac apps.

Let’s get a move on.

Chat & instant messaging

1. Yahoo Messenger
Desktop chat client for Yahoo!
http://messenger.yahoo.com

2. MSN Messenger
Desktop chat client for the MSN network
http://www.microsoft.com/mac/products/messenger/default.mspx

3. aMSN
A MSN Messenger clone but with more features
http://www.amsn-project.net

4. Chax
A modified clone of iChat
http://www.ksuther.com/chax/

5. Colloquy
An IRC Client
http://colloquy.info

6. Skype
Chat and VoIP desktop application
http://www.skype.com

7. ooVoo
A video chat client
http://www.oovoo.com
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Mail

1. Thunderbird
Mozilla’s desktop email client
http://www.mozillamessaging.com/en-US/thunderbird/ 

2. Mail.appetizer
Displays a preview of incoming emails
http://www.bronsonbeta.com/mailappetizer/beta/ 
http://www.makeuseof.com/tag/4-useful-plug-ins-to-extend-apple-mails-functionality/ 

3. Notify
Elegant menubar app that notifies you of new emails
http://vibealicious.com/apps/notify/ 
http://www.makeuseof.com/tag/notify-an-elegant-solution-to-multiple-gmail-notifications-
mac/ 

4. Attachment Scanner
Detects keywords and reminds you to attach files
http://eaganj.free.fr/code/mail-plugin/ 
http://www.makeuseof.com/tag/4-useful-plug-ins-to-extend-apple-mails-functionality/ 

5. Google Notifier
Google’s menubar app to inform you about new emails and display reminders regarding 
upcoming Google Calendar events
http://toolbar.google.com/gmail-helper/notifier_mac.html 

Browsing

1. Firefox
http://www.mozilla.com/en-US/firefox/firefox.html 

2. Opera
http://www.opera.com

3. Camino
Open source web browser
http://caminobrowser.org

4. Google Chrome
Currently, only a developer release for Mac
http://www.google.com/chrome/intl/en/eula_dev.html?dl=mac 
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5. OmniWeb
http://www.omnigroup.com/applications/omniweb/ 

6. Shiira
Browser developed based on Webkit
http://shiira.jp/en 

7. Stainless
Developmental multi-process browser for Leopard
http://www.stainlessapp.com
http://www.makeuseof.com/tag/stainless-google-chromes-mac-twin-mac-only/ 

8. Fluid
Site-specific browser based on Prism
http://fluidapp.com

9. SeaMonkey
Browser based on Mozilla
http://www.seamonkey-project.org

Safari plugins
1. Cooliris

Amazing image browser for Flickr, Google Images, Facebook, Picasa, YouTube, etc.
http://www.cooliris.com
http://www.makeuseof.com/tag/take-a-closer-look-at-your-pictures-with-cooliris/

2. Inquisitor
Search engine plugin
http://www.inquisitorx.com/safari/index_en.php 

3. Glims
Adds search suggestions, undo closed tabs and other useful features
http://www.machangout.com
http://www.makeuseof.com/tag/safari-search-plugins-showdown-glims-vs-inquisitor-
mac-only/ 

4. SafariBlock
Advertisement blocker based on AdBlock
http://code.google.com/p/safariblock/ 

5. SafariStand
Multi-functional Safari plugin that adds a sidebar, quick search and History Flow
http://hetima.com/safari/stand-e.html 
http://www.makeuseof.com/tag/one-safari-plugin-you-should-install-safaristand/ 
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Text Editors

1. TextWrangler
Text editor that is also capable of coding HTML
http://www.barebones.com/products/textwrangler/ 

2. Bean
Easy-to-use rich text editor
http://www.bean-osx.com/Bean.html 

3. NeoOffice
Mac OS X version of Sun Microsystem’s productivity suite, OpenOffice
http://www.neooffice.org/neojava/en/index.php 

4. OpenOffice
Free productivity suite
http://www.openoffice.org

Image Editors

1. GIMP
Free alternative to Photoshop
http://gimp-app.sourceforge.net

2. Seashore
Simple open source image editor
http://seashore.sourceforge.net

3. Picasa
Free photo editing software from Google
http://picasa.google.com/mac/ 

4. LiveQuartz
Powerful photo retouching software
http://www.rhapsoft.com

5. Jing
Create screenshots and screencasts
http://www.jingproject.com
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Getting Things Done (GTD)

1. Evernote
Centralized note-taking and mobile syncing application
http://www.evernote.com

2. Anxiety
Easy to use to-do application
http://www.anxietyapp.com

3. SimpleTask
Fully-featured task-prioritizing application
http://www.simpletaskapp.com/mac.html 

4. TaskMate
Another simple to-do application
http://gettaskmate.com

Music

1. GimmeSomeTune
Fetch artwork, lyrics with this iTunes controller with Last.fm scrobbling support
http://www.eternalstorms.at/gimmesometune/ 

2. You Control: Tunes
iTunes controller and cover art overlay display
http://www.yousoftware.com/tunes/tunes.php 

3. ScrobblePod
Menubar apps that queues songs for scrobbling to Last.fm
http://www.scrobblepod.com

4. Amazon Album Art Widget
Retrieves album art from Amazon
http://www.widget-foundry.com/widgets/amazonart.htm 

5. DesktopLyrics
Displays lyrics on the desktop
http://www.corecode.at/desktoplyrics/index.html 
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Pro Tips
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Come a long way, haven’t we? In this short ebook, we’ve gone back to basics 

and slowly made our way up again. We’ve taken a look at two apps that every Mac user 
should learn to use: Disk Utility and Activity Monitor. We’ve also learned how to set up and 
integrate Mail, iCal and Address Book into our daily routine.

Now, we shall take a quick look through some pro tips. Most of these tips were selected from 
Apple’s arsenal [http://www.apple.com/pro/tips/], I’ve added some of my own and others I’ve 
gathered from other sources.

I hope that you will learn to utilize these tips and become a better-equipped Mac user.

All about screenshots
To take a screenshot of the entire screen - Command + Shift + 3
To take sectional screenshot - Command + Shift + 4

To take a screenshot of a window or a menu - Command + Shift + 4 then hit Spacebar; 
the crosshair will change into a camera. Click to take the screenshot.

Save a screenshot of the screen on the Clipboard - Command + Control + Shift + 3
Save a sectional screenshot on the Clipboard - Command + Control + Shift + 4

Delete stubborn files
Sometimes Trash refuses to empty because certain files are in use.

In Leopard, hold the Option key while clicking ‘Empty Trash’
In Snow Leopard, securely emptying the Trash does the trick. Hold the Command key, 
‘Empty Trash’ changes to ‘Securely Empty Trash.

Stop applications from starting on login
Applications set to launch on login are listed in System Preferences -> Accounts under the 
Login items tab.

To stop an application from starting up, select it then click the remove (minus) button

Merge Safari windows
Sometimes surfing gets a little too cluttered when you have too many Safari windows 
opened. You can merge them into just one window by going to the Window menu in Safari 
and selecting “Merge all Windows”.

Browse through tabs
Pressing Command + Shift + Left/Right arrows lets you scroll through opened tabs in 
Safari.
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Save a webpage for offline browsing
Find an interesting webpage and would like to save it to later reading? Save it as a PDF to 
read later. Press Command + P and click the PDF button. Set the file name and destination 
then click Save.

Save a bookmark anywhere
Pull the favicon from Safari’s address bar to quickly save a bookmark to that page anywhere, 
even on your desktop.

Remember if you’ve saved a file
While working with a document, the red Quit button has a dot in the middle if there is any 
unsaved work.

Send a webpage via email
While still in Safari, press Command + Shift + I to instantly compose an email containing the 
URL of the page you’re currently browsing.

Otherwise, press Command + I to send the entire webpage via email.

Copy and Paste
To copy, select an item and press Command + C
To paste, press Command + V

To paste and match the formatting of the destination document, press Command + Option 
+ Shift + V

Display the Keyboard viewer
Sometimes, locating the keystroke for “€” isn’t easy. To find other lesser-used characters 
easily, use the Keyboard Viewer.

Open System Preferences, click on Languages & Text. The left column, check the box next to 
“Keyboard & Character Viewer” to activate them. Subsequently, check “Show Input menu in 
menu bar” for easy access to the Keyboard Viewer.

Quickly set any application to startup during login
If you find that the application you’re currently using could benefit from launching during login, 
right click on its Dock icon and select “Options” -> “Open at Login”.

Create ZIP files
No additional software is necessary. Select all the files you’d like to zip up, right-click on one 
and select “Compress X items”.
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Close multiple windows instantly
Option click the red quit button to simultaneously close every window by the same 
application.

Minimize into Dock icons
Snow Leopard only.
Sick of seeing so many minimized window icons on your Dock? Minimize them into the 
application’s Dock icon. Click on the Apple icon in the menu bar. Select Dock -> Dock 
Preferences. Check “Minimize windows into application icon”.

Minimized windows are now sucked into their application’s Dock icons. To view them, invoke 
Exposé to show all windows. Minimized windows are displayed below the active windows 
and are separated by a line. 

Control-click on each one to bring it back up or Option-click to restore all minimized 
windows.

Set your display to sleep instantly
Snow Leopard only.
In addition to invoking Exposé and activating the screen saver, OS X now has the option to 
set an active screen corner to put your display to sleep.

Go to System Preferences, click on Exposé & Spaces. Under the Exposé tab, choose a 
corner to turn your display off.

Quickly navigate between folders
To move up one folder level, press Command + Up arrow. 

To delve into a selected folder, press Command + Down arrow.

Increase the font size (Quickly zoom in/out)
This trick works in almost any application. Press Command + Minus to reduce the font size 
(zoom out) and Command + Plus to increase (zoom in).

Save Spotlight searches
If you search for a specific term regularly, for example images with “img” in the file name, you 
can make Spotlight automatically search for them and place the results in a folder on your 
desktop.

Following the example, invoke Spotlight and enter the search terms “kind:image img” and 
click on ‘Show All’. In the Finder window that appears, click on the Save button on the upper 
right corner. Set an appropriate title and choose Desktop as the destination then click Save. 

This folder will automatically update with the search results live.
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Cheat Sheet

General
Command + C	 	 	 	 	 Copy
Command + X	 	 	 	 	 Cut
Command + V	 	 	 	 	 Paste
Command + Option + Shift + V	 	 	 Paste and Match Style

Command + Z	 	 	 	 	 Undo
Command + Shift + Z	 	 	 	 Redo

Command + W	 	 	 	 	 Close window
Command + Q	 	 	 	 	 Quit application
Command + H	 	 	 	 	 Hide application
Command + M	 	 	 	 	 Minimize window

Finder
Command + A	 	 	 	 	 Select all
Command + I     Show ‘Get Info’ window
Command + Option + I	 	 	 	 Show Inspector
Command + Delete	 	 	 	 Send to Trash

Safari
Command + T	 	 	 	 	 New tab
Command + N	 	 	 	 	 New window
Command + R	 	 	 	 	 Reload page
Command + Shift + Left/Right arrow		 Cycle between tabs in Safari
Command + D	 	 	 	 	 Bookmark Page
Command + Option + A	 	 	 	 Show Activity Window
Command + F	 	 	 	 	 Find in page

Others
Command + N	 	 	 	 	 New document
Command + O	 	 	 	 	 Open document
Command + T	 	 	 	 	 Show font palette
Command + ,	 	 	 	 	 Preferences
Command + S 	 	 	 	 	 Save
Command + Shift + S 	 	 	 	 Save As...
Command + P	 	 	 	 	 Print
Command + F	 	 	 	 	 Find in page
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Visit MakeUseOf.com for daily posts on cool websites, free software and internet tips. If you 
enjoyed this guide/manual then subscribe to MakeUseOf.com (via feed or email) and get 
instant access to several other such guides and cheat sheets to your favorite programs.

• www.makeuseof.com - Latest articles

• www.makeuseof.com/dir/ - Cool websites by category
• www.makeuseof.com/most-popular/ - Most popular articles

• http://feedproxy.google.com/Makeuseof - Feed
• http://feedburner.google.com/fb/a/mailverify?uri=Makeuseof&loc=en_US - Subscribe via 

email

Don’t miss out on our other cool manuals!
Subscribe via email or RSS to download!
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